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GideonSoft Overseer User Guide 

Overview: 
An Overseer is a set of permissions assigned to the user of a Module and the Instances 
associated with it.  Overseers have more access that Power Users and Basic Users, but fewer 
capabilities than Admin Users. 

 

The permissions are outlined as follows: 

• Create a new Measurement Period/Instance and/or delete a Measurement 
Period/Instance 

• Manage people by creating new users, importing/exporting new and existing users, 
creating groups and teams, and assigning people to those groups and teams 

• Manage Power Users’ and Basic Users’ statuses and descriptives 
• Grant access and reset passwords 
• Shadow users 
• Create, record, and edit observations 
• Complete, review, and activate surveys 
• Import/export, input, and edit data 
• View Module and Instance reports 
• Open and close Measurement Periods/Instances 

 

The following document is organized by the Module and Instance configuration settings that are 
needed to get started, and then broken down by the core features that are available within each 
of the main tabs: People, Observations, Surveys, Data, and Reports. The final section contains 
instructions on utilizing the mobile application. 
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Note: The User Guide is intended to be a resource for Overseers who have already completed Overseer 
Certification Training. Some of the features described in this document may not be currently utilized in 
your organization.  
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Navigation: 
There are two menus that are used to navigate throughout the website. The main navigation is 
located at the top-right of the screen and accessible by clicking on the location text. 

 
1. Location Text: Displays where you are in the app at all times. You can think of it as a bread 

crumb trail. The screenshot above shows you are located in the Module, Overseer Training, 
and the Instance, Class 1234. Clicking on this text will take you to that Module or Instance, 
and clicking on the “Hamburger” icon will reveal the Top-left menu. 

2. Top-left Menu: Shows all modules you have access to. Clicking on the Module (e.g. 
Overseer Training) will reveal the instances you have access to (e.g. Class 1234). Use this 
menu to move between the Organization, Module, and Class levels.  A filter mechanism 
has also been included which will filter in real-time as you type. 

3. Right Menu (icons): Contains all the task-specific tabs that a user can access within the 
app. (This list is customizable as of version 22.1 via the pencil edit icon) 

4. Observations ( ): Allows you to quickly capture behavior observed. 

5. Surveys ( ): Lists all the current surveys you have access to complete. 

6. Reports ( ): Lists all the reports you have access to generate. 

7. Data ( ): Compiles all of the spreadsheets you can access to either input data or export 
data (e.g. entering Runs, Swims, O’Courses, TAPS or Written Exam scores). 

8. People ( ): Displays all of the people in the class. Selecting a subject will bring you to 
their Individual Instance Profile. This profile will show you if they are currently active, 
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generate specific reports on them, and list all observations recorded on this individual 
within this Instance. 

9. User Profile ( ): Clicking on your user icon at the top RIGHT will reveal your user options 
(e.g., Global Profile, Notifications, Logout) and additional links. Clicking on your Global 
Profile will allow you to change your password and view your location within the 
organization (i.e., courses and permission sets you are allowed). 

1. Module and Instance Configuration 
The purpose of this section is to explain the differences between the Module and Instance. 
Essentially, the Module is a container for the template from which all of the Instances are built. 
This means that any settings and configurations that exist at the module-level will be reflected 
in an Instance that is created from the Module. Changes that are made at the module-level will 
not affect any Instances that were created prior to the changes. 

Before creating your first Instance, you should ensure that the configuration and settings are 
correct at the module-level. After creating an Instance, you can also manage settings and 
configurations at the instance-level. However, when you make changes at the instance-level, 
they will not be saved in the Module template. In other words, the changes you make at the 
instance-level will only live in that Instance. Therefore, it is suggested that any configuration 
changes be made at the module-level, unless there is a unique circumstance in a particular 
Instance. To make changes at the module-level, start from the Module Homepage. To make 
changes at the instance-level, start from the Instance Homepage.  

1.1. Module-Level Settings 
The following settings should be configured at the module-level before creating a class. These 
settings are necessary to facilitate creating an Instance and adding users. 

1.1.1. Roles 
Role are types of users that are attached to permission sets. Roles are unique to your 
organization; whereas permission sets are built into GideonSoft. When people are added to the 
system, they must be assigned a role. Before assigning roles, the roles must be created and 
attached to a permission set. This makes it so that all users added to the system with a specific 
role have the same permissions. Overseers can create roles with the following permission sets: 

• Overlord (Module-Level): Gives the user access to the Module and instances but does not 
mean they are “members” of the Instance. They will not show up in the roster, surveys, 
spreadsheet, etc.  An Overseer does, however, have the ability to Shadow users 
(impersonate).  Overseers have the ability to do most anything at the Module level and 
lower (create, review, update, and delete most everything). 
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• Report Viewer (Module-Level or Instance-Level): Lets users have access to view reports 
but nothing else. They will not show up in the roster, surveys, spreadsheets, etc. Report 
Viewers are usually high ranking individuals in an organization. By default, they can see 
ALL reports (unless they are specifically denied access).  

• Data Viewer (Module-Level or Instance-Level): Lets users have access to view data and 
reports but nothing else. They will not show up in the roster, surveys, spreadsheets, etc. 
Data Viewers are usually researchers, data warehouse administrators, or data scientists 
within an organization. By default, they can view ALL reports (unless they are specifically 
denied access), view data, and export the data but they cannot change anything. 

• Overseer (Instance-Level): Provides access to everything in an Instance without the ability 
to configure or delete information. 

• Power-User (Instance-Level): Provides access to things like spreadsheets and the 
import/export tool, surveys, observations, reports, and view and manage Basic User’s 
profiles. 

• Data Entry User (Instance-Level): Lets a user complete surveys and record behaviors on 
behalf of someone else. This user also can input data into Spreadsheet. Essentially, this 
role is reserved for users that will be responsible for inputting data for other people. It is 
very important the Overseer monitor closely users in this role because they are given 
authority to represent other users in the system. 

• Basic User (Instance-Level): Lets users complete surveys assigned to them and view their 
data. They cannot access things like Spreadsheets or import or export data. Basic Users 
are limited to very specific tasks including surveys, observations, and reports that are 
assigned to their role. 

1.1.1.1. Configuring Roles 
• From the Module homepage select the People icon ( ) at the top RIGHT → “Manage” → 

“Roles” 
• Click “New Role” → Type the name of the Role (ex. Student) → Select whether or not this 

Role is primarily an Observer or is Observed → Select a permission set from the dropdown 
menu (ex. Basic User) → Select a Parent role for this role (optional) → Click “OK” 

1.1.2. Groups 
Groups are used to create subsets (teams) of people within an Instance.  For example, if the 
participants within an Instance need to be broken down into separate groups for organizational 
or analytical purposes (e.g., teams, squads, etc.), those groups can be created at the Module level 
and then individuals can be assigned to teams at the Instance level (See Section 1.2.3). 
Individuals can also be placed into multiple groups. 

This feature can also be used to limit people within groups to specific surveys and assessments. 
For example, individuals could be grouped by squads and rate only their squad members’ 
performance, rather than every individual in the Instance. In these cases, surveys are configured 
with a target group, and users are prompted to select a team from within that group to complete 
the survey on. 
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1.1.2.1. Configuring Groups 
• From the Module homepage, select the People icon ( ) at the top RIGHT → “Manage” → 

“Groups.”  
• Select “New Group” to create a new group.  
• Provide a name and select the group from the available roles you wish you create the 

group from. Click “Save” 

1.1.2.2. Editing Groups 
• To edit the group, click on the group name, then click “Edit” to make any revisions to the 

name or role. 

1.1.2.3. Configuring Positions 
• Configure Positions in the group by clicking the name of the group → “Configure 

Positions” → Type the name of the position (ex. Leader) → “Add Position” → Save 

1.1.3. Statuses 
Statuses are used to track a Basic User’s presence within an Instance. There are two types of 
statuses: Active and Inactive. When the user is assigned an Inactive Status he/she can no 
longer access the Instance. An inactive user will also not show up in reports or evaluations. 
Statuses can be configured to denote specific reasons for being active or inactive. For example, 
a student who voluntarily leaves training could be assigned an inactive status of “Drop on 
Request”, while a student who leaves training due to an injury could be assigned an inactive 
status of “Medical Drop.” 

1.1.3.1. Configuring Statuses 
• From the Module homepage, select the People icon ( ) at the top RIGHT → “Manage” → 

“Status.” 
• Select “New Status” → Type in the name of the status (ex. Drop on Request) → Type in a 

shortened version (a few letters) of the status under “Code” (ex. DOR) → Select active or 
inactive → “Save” 

1.1.4. Descriptives 
Descriptives are additional pieces of information about a user. These are typically written in a 
text-format, but they can also be numerical values like age and dates. Some common examples 
are sex, rank, hometown, and education. Descriptives are useful for the purposes of analyses 
because they allow people to be grouped based on common background characteristics. Using 
the example of age, you might find that older individuals perform better than younger individuals 
in events that require situational judgment. There is no limit on the number of descriptives you 
can add; it’s best to start with pieces of information your organization is already tracking. As 
you add users, you will be prompted to enter their descriptives. 
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1.1.4.1. Configuring Descriptives 
• From the Module homepage, select the People icon ( ) at the top RIGHT → “Manage” → 

“Manage People Descriptives.” 
• Select “New Descriptive” → Select “Add New Descriptive” → Type in the name of the 

descriptive (ex. Age) → Select the type (i.e., format) → Select a Role to show this 
Descriptive on the user Profile page for as a quick-edit (optional) → Select the checkbox 
to include this variable for in-processing during the new user creation wizard (optional) → 
click “Save” 

o You also have the option to encrypt sensitive information 

1.1.5. Adding Users to the Module/Division-Level 
Module-Level Users include: Overseers, Data Viewers, and Report Viewers 

1.1.5.1. Create a New User 

To create a new user who has never been in the system before: 

• From the Module homepage, select the People icon ( ) at the top RIGHT → “Module 
Assignments” → “Add Assignments” → “Enter Manually” → “Add New Person.” 

• Add the following information:  

First Name, Last Name, Username, Password, Email, Instance Identifier, Global 
Identifier (Organization-level username), Build Identifier (identifier shown in 
Assignments), General Global Variable (Organization-level identifier). Note: all fields 
are required except for Email and General Global Variable.  

• Click Next.  
• Optional: Enter any descriptives, such as Status, Hometown, etc. Click Next. 
• Select a role assignment. Click Save. 

1.1.5.2. Add an Existing User 

To add someone who is already in the system but who has not yet been added to this Module: 

• From the Module homepage, select the People icon ( ) at the top RIGHT → “Import 
People” → “Select People from a Previous Module or Instance” (to add multiple users at 
once) or “Search for a Specific Person.” 

• Type the user’s name in the search field and click the search button. 
• Select the user(s) you wish to add. 
• Select the role on the right to add the selected users to. The “Smart Assign” button will 

attempt to match any existing roles to any roles in the incoming Module. 
• Click “Add X Person to Import List.”  
• At the next screen, click the “Review X person and complete the import” button. 
• Fix any missing field names or errors (in red) on this screen, then click the green “Import 

X Person” button at the bottom right. 
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• You can auto-generate Identifiers, Global Identifiers, Usernames, or Passwords on this 
screen by clicking the gear icon next to each. 

• To remove any users, click the red “Remove X Person” button at the bottom right. 

1.1.5.3. View Module/Division-Level Users 

To review individuals assigned at the module-level: 

• From the Module homepage, select “People” → “From Any Instance.” 

1.1.6. Creating Class Objects 
Class objects are anything that you want to evaluate that is not an individual. For example, if you 
want to complete a survey evaluating the facilities where the training takes place. Once a class 
object has been created, surveys can be configured with a target set to the object. To create a 
class object: 

• From the Module homepage, select the gear icon ( ) at the top RIGHT → “Measurement 
Period Objects” →”New Object” 

• Enter the name of the Object 
• You can also assign the object to a role so that the object shows up in evaluations with a 

target of that role. 

1.2. Setting up an Instance 

1.2.1. Creating an Instance 
Creating a new Instance will copy all the software configurations and reports from your custom 
Module into an Instance. 

• From the Module homepage, click the gear icon ( ) at the top RIGHT.  
• Select the BIG GREEN “Create a New Measurement Period” Button. 
• A box will open with the following prompts: 
• Name: Enter the name of the Instance here (ex. Class 2016) 
• Options: Select the default option, “Import statistics from the template (default)” 
• Click “Create” 

1.2.2. Adding Users to Instance-Level 
Instance-Level Users include: Basic Users, Power Users, Data Viewers, Report Viewers, Data 
Entry Users, and Ovserseers. 

1.2.2.1. Create a New User 

To create a new user who has never been in the system before: 

• From the Instance homepage, select the People icon ( ) at the top RIGHT → “Import 
People” → “Create a New User.” 
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• Add the following information: 

First Name, Last Name, Username, Password, Email, Instance Identifier, Global 
Identifier (Organization-level username), Measurement Period Identifier (identifier 
shown in Surveys and Observations), General Global Variable (Organization-level 
identifier). Note: all fields are required except for Email and General Global Variable). 

• Click Next.  
• Optional: Enter any descriptives, such as Status, Hometown, etc. Click Next. 
• Select a role assignment. Click Save. 

1.2.2.2. Create and Add Multiple Users (Bulk Inprocessing) 

To add large groups of people at once using a CSV file: 

• From the Instance homepage, select the People icon ( ) at the top RIGHT → “Import 
People” → “Import People From a Spreadsheet.” 

• Click the “Click here to download a template for importing people” link to download an in-
processing spreadsheet. 

• This sheet serves as a template to properly import batches of users.  
• Open the spreadsheet and begin entering the data. The spreadsheet will contain the 

following columns for each user (required fields are noted with *): 
• *Identifier - [Class] Measurement Period Identifier 
• *First Name 
• *Last Name 
• *Username 
• *Password 
• *Global identifier 
• GGV - General Global Variable 
• Save and close the spreadsheet when you are finished. 
• Be sure to save the file in the existing format (.CSV) 
• Excel files that contain formulas cannot be imported, they must be “values only”. If you 

are using formulas to create this sheet, copy the contents of the sheet and “paste special” 
as values only. 

• Upload the file by clicking the “Upload a list of people in a CSV file” button or by simply 
dropping your CSV file onto that box on the page.  

• Map the columns in your spreadsheet to the available GideonSoft columns on this next 
screen. It is important to note that you can simplify this import process by creating a 
column in your spreadsheet that lists the Role (or multiple Roles separated by commas) 
that the user on each row should be assigned to. You can map that column to either the 
“Role” or “Role List (delimited)” in the GideonSoft columns to automatically add each user 
to their intended Role. 

• Click “Add X Person to Import List.”  
• At the next screen, click the “Review X person and complete the import” button. 
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• Fix any missing field names or errors (in red) on this screen, then click the green “Import 
X Person” button at the bottom right. 

• You can auto-generate Identifiers, Global Identifiers, Usernames, or Passwords on this 
screen by clicking the gear icon next to each. 

• To remove any users, click the red “Remove X Person” button at the bottom right. 

1.2.2.3. Add an Existing User 

To add someone who is already in the system but who has not yet been added to this Instance: 

• From the Instance homepage, select the People icon ( ) at the top RIGHT → “Import 
People” → “Select People from a Previous Module or Instance” (to add multiple users at 
once) or “Search for a Specific Person.” 

• Type the user’s name in the search field and click the search button. 
• Select the user(s) you wish to add. 
• Select the role on the right to add the selected users to. The “Smart Assign” button will 

attempt to match any existing roles to any roles in the incoming Module. 
• Click “Add X Person to Import List.”  
• At the next screen, click the “Review X person and complete the import” button. 
• Fix any missing field names or errors (in red) on this screen, then click the green “Import 

X Person” button at the bottom right. 
• You can auto-generate Identifiers, Global Identifiers, Usernames, or Passwords on this 

screen by clicking the gear icon next to each. 
• To remove any users, click the red “Remove X Person” button at the bottom right. 

1.2.2.4. Re-associate People  

Sometimes a person may have been entered into the app more than once. This tools lets you 
combine that person’s data 

• From the Instance homepage, select the People icon ( ) at the top RIGHT → “Manage” 
→ “Re-associate People.” 

• Select a member you would like to re-associate. Click “Next.” 
• Select the Instance you would like for the global person re-association to effect  
• You will then have the option to create a new global user or associate with an existing one. 
• “Choose existing global user” will be already be selected. However, you also have the 

option to select if a new global user should be created. 

1.2.3. Creating Teams 
The system has the capability to collect data in teams and organize such evaluations 
automatically. There are two steps required before you can assign people to teams. First, Groups 
must be created; then, Teams of a designated type must be created. A group is really nothing 
more than a container for people that can be assigned to teams; it defines or categorizes what 
kind of teams will be needed. Groups are typically configured at the Module level and evaluations 
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are created with a target group. Teams are created at the Instance level. Once teams have been 
created, you can then assign people to those teams.  

• From the Instance homepage, click the People icon ( ) at the top RIGHT → “Manage” → 
“Groups.”  

1.2.3.1. Create a new team 
• Click the name of the group → “Manage Teams.” This will take you to the Team 

Configuration page, where you can assign individuals to teams and sort teams as needed. 
• To create custom teams, click “Add Team” and type a name for the new team → Click 

“Save” 

• To edit an existing team, click the icon. 
• To remove a team, click the  icon. 

1.2.3.2. Assign individuals to teams 
• From the Team Configuration page, select the appropriate individuals click “Assign,” and 

then select the team you wish to assign those individuals. 
• To remove an individual from team, click the  icon. 

1.2.3.3. Create random teams 
• From the Team Configuration page, click “Sort Teams.”  
• Enter the number of teams you with to sort individuals into. 
• The team sorter will randomly assign individuals to the number teams specified. 
• You can also apply rules to the team sorter feature. This feature randomly sorts the teams 

based on values of a particular variable. For example, if you may want the strongest 
runners to be evenly distributed throughout the teams. You can apply multiple rules to the 
team sorter feature. 

• Select “Apply Rule” → Score → Select a variable or descriptive → Select “ascending” for 
scores where higher values are good, or “descending” for scores where lower values (e.g. 
times) are better → “Apply” 

•  To remove a rule, click the  icon. 

1.2.3.4. Assign a position 

• Click “Select One” under the Position label. If positions have been configured, they will 
appear in a list → Select the appropriate position → Click “Save.” 

1.2.4. Closing an Instance 
After all of the data for an Instance has been collected, you should close it. This prohibits users 
from accessing the Instance and essentially “locks-in” all of the data. You should NEVER delete 
an Instance unless you are sure you want to delete all of the data that was collected; this is 
done from the Module homepage settings. 

• Go the Instance homepage and select the gear icon ( ) at the top RIGHT.  
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• From the dropdown menu that currently displays “Open,” click on this box and select 
“Closed.” The Instance is now closed. 
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2. Core Features 
2.1. People 

2.1.1. Viewing People 
2.1.1.1. View in list format 

This format will be more useful is you wish access the Manage function which allows you to 
assign people to teams, change multiple statuses at once, edit descriptives, etc. 

• Select the People icon ( ) at the top RIGHT 
• You can filter people by their roles (e.g., coaches, cadre, students, recruits) as well as their 

status (all, active, inactive). 
• You may search for people by using the “Search people” box. Type in this box and the 

people list automatically filters to your search. 

2.1.1.2. View in tile format 
• Tile format will be available after you select the class you wish to view. On this class 

homepage, you will be able to view all people in the class. 
• Profile pictures, if assigned, will be shown in this view. 
• You can filter people by their roles (e.g., coaches, cadre, students, recruits) as well as their 

status (all, active, inactive). 
• Overseers can filter the type of users that are show in the tile format based on role and/or 

status. 
• From the Module homepage, click the gear icon ( ) at the top RIGHT → scroll to the 

sentence “On the Measurement Period homepage…” → click on the blue text to change 
the settings based on role or status. 

2.1.2. Individual Class Profile Page 
To view a person in more detail, click on their name from either the tile or list format. You will be 
taken to this person’s class profile. From this page you can: 

2.1.2.1. Change or remove a profile picture 
• Click on the gear icon next to the person’s name, then hover over the picture to display 

these options.  

2.1.2.2. Change the username 
• Click on the gear icon next to the person’s name, then Click on the username → Edit text 

→ Select the  icon to save changes, or the  icon to cancel.  
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2.1.2.3. Change a person’s status 
• Click on the person’s current status (shown as a green star if currently “Present”) → Select 

new status from the dropdown box → Add comment (if applicable) → Save   

2.1.2.4. View observations 
• On a user’s Profile, note that red/gray/green bar chart that indicates the count of 

negative/neutral/positive observations this user has received. Depending on the Module 
configuration, this observation widget can be hyperlinked to an existing Behavioral 
Observations report as well. 

2.1.2.5. View reports 
• In the “Quick Links” section of a user’s Profile, click on “Reports” → Select a Report and a 

new window will open. 

2.1.2.6. View/Edit current groups and roles 
• Scroll down past the Quick Links sections to the Groups and Roles sections 
• To edit roles, click “Edit” → Click “Add New” to add a role or “x“ to remove a role 
• To edit groups, click “Edit” then refer to Section 1.2.3.2 on assigning individuals to teams 

2.1.2.7. View/Edit Data 

• In the “Quick Links” section of a user’s Profile, click on “data” to view data associated 
with an individual. You can use the “Showing” dropdown list to filter the following types 
of data: 

o Descriptives: provide information about a person such as status, gender, age, or 
hometown 

o Scores: any data points that have been calculated for the person 
o Evaluations: ratings made about the individual or by the individual. After selecting 

this, you can click the “Advanced Search” to further filter evaluations given, 
received, etc. 

o Ranks: any data points (scores) that have been calculated to rank (“Rack and 
stack”) individuals 

• To view the data outside of the software, click “Export to CSV” at the bottom of the page. 

2.1.2.8. Set Baseline/Exclude Evaluations 

Individual’s evaluations can be flagged as a baseline or exclude. A baseline evaluation is a value 
that is tagged as a reference point and can be used as a point of comparison for future 
evaluations. For example, the number of shots made on a typical day may be tagged as a 
baseline, and compared to the number of shots made after a week of training. The exclude 
function is used for values that are not considered representative of typical performance. If an 
individual is having an off day, and Overseer can mark their score as “exclude” so that it does 
not impact their overall performance ranking. To mark scores as baseline or exclude: 

• In the “Quick Links” section of a user’s Profile, click on “Data.” For any evaluations listed, 
select “baseline” or “exclude” under the “flag” column. 
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2.1.2.9. Reset passwords 
• If a user has forgotten their password, click “Reset Password,” then type in a new 

password. 

2.1.2.10. Grant System Access 
• At the bottom of the page, specify whether a user should or should not be able to access 

GideonSoft by clicking on the blue hyperlink. 

2.1.3. Managing Multiple People 
2.1.3.1. Change Multiple Users’ Status 

• From the Instance homepage, select the People icon ( ) at the top RIGHT →  “Manage” 
→ “Status.”  

• Put a checkmark in the boxes next to the people you would like to change.  
• Click on “Update Selected.” 

o This will open a pop-up window that will allow you to select a new status and 
document any notes that you would like to include with this status change.  
 A list of possible status assignments to choose from are based on the list 

created at the Build level.  
 Once you have made your selection, press the “Update” button to save and 

close.  
o You will be returned to the main Status Assignment page. All selected people will 

now have the new status assignment, notes, and a new timestamp.  

2.1.3.2. Update Descriptives 
• From the Instance homepage, select the People icon ( ) at the top RIGHT →  “Manage” 

→ “Manage People Descriptives.” 
• Click on the title of the descriptive to enter a spreadsheet view. From here, you can input 

and edit multiple individuals’ descriptives in one place. 

2.2. Observations 

2.2.1. Configuring Observations 
Overseers have the ability to create observations, which includes creating events, behaviors, etc. 
for their Module or Instance. If Observations are configured at the Module level, they will be 
available in every NEW Instance that is created thereafter. If Observations are configured at the 
Instance level, they will only be available in that Instance. 

2.2.1.1. Create a New Observation Event 
• Select the Observations icon ( ) at the top RIGHT of either the Module or Instance 

Homepage 
• Click “Design” then “New Event.” 
• Options in the “General” tab will appear. From here, you will be asked to:  
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• Name the event. 
• Select who will be making the observations from the dropdown list. 
• Select who will be observed from the dropdown list. 
• If you wish to add a filter to the target people list, select groups by which the people will 

be filtered. 
• To make evaluations as 360 assessments, check the box.  
• To allow comments to be added to observations, check the box.  
• To require comments on all observations, check the box.  
• You may check “allow interactions to be specified on observations” box if you wish to 

allow interactions. Interactions enable you to select multiple people involved in a behavior 
and indicate primary and secondary roles. 

• Enter in the (optional) Start and End date for this event. 
• Click “Create Event.” 

2.2.1.2. Configure Observation Pre-Questions 
• Select the Observations icon( ) from the top RIGHT of either the Module or Instance 

Homepage 
• Click “Design” → Click the name of the Event 
• Pre-Questions can be used for to differentiate between events that occur more than once. 

Enabling this feature prompts users to make a selection before recording a behavior. 
• Drag the “Pre-Question” tag onto the tab on the right. Type in question itself (ex. Training 

Day) → Type in the question responses (ex. Day 1; Day 2; Day 3). → Click “Add” 

2.2.1.3. Add Behaviors to an Event 
• Select the Observations icon ( ) at the top RIGHT of either the Module or Instance 

Homepage 
• Click “Design” → Click the name of the Event → Select “Positive/Negative/Neutral” from 

the left and drag it to the righthand side 
• Type the behavior under “Label” 
• Assign the behavior a Severity. A “Severity” indicates how good or bad the behavior is 

weighted. For example, a minor safety violation might have a severity of “-1” while a major 
safety violation has a severity of “-3.” 

• Indicate whether you wish to sort this behavior at the top or bottom of the list of behaviors 
(otherwise it defaults to an alphabetic sort of behaviors in the list). 

• Behavior filters allow you to group similar behaviors together. This enables the user to 
filter down the list of behaviors shown for an event. The most common filters are positive, 
negative, and neutral.  

• Under “Filters”, select a generic filter from the dropdown menu OR enter in a list of filters 
in the box. 

• Behavior tags can be used to group similar themes of behaviors together across events. 
This helps to track the types of behaviors an individual is exhibiting across events. For 
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example, behaviors like “encouraging teammates,” “positive attitude,” and “motivator” 
could be tagged as “Team Player” 

• Under “Tags”, select a generic tag from the dropdown menu OR enter in a list of tags in 
the box. 

• Click “Add” 
• When you are finished adding behaviors and configuring this event, click “Publish” 

2.2.2. Recording Observations 
All observations must be recorded within an Instance and, therefore, you must be signed into a 
specific Instance to utilize the Observations feature. As an Overseer, you typically cannot 
complete Observations as yourself unless you are also assigned to an instance-level role. If you 
are not assigned a role that allows you to record observations, you will be prompted to 
impersonate (i.e., shadow) another user. 

2.2.2.1. Shadow Users 
• Select the Observations icon ( ) at the top RIGHT 
• A list of individuals to shadow will appear. Select the person you wish you to impersonate. 

The observation will be attributed to the person you select. 
• Click “Where?” to select the event you wish to view . 

2.2.2.2. Create a new Observation 
• Select the Observations icon ( )  at the top RIGHT 
• Click on “Where?” to select the “Event” in which you observed the behavior 

o You can filter a specific event using the search box.  
o You can “lock” this event by clicking on the Lock icon in the “Where?” section 

• Select the individual(s) on which you will make the observation by clicking on their name 
under the “Who?” section 

o You may select more than one person at a time to record the same behavior 
o For team events, you can filter this list by selecting a team from the drop down 

filter menu icon above the list of individuals so it will only show individuals from a 
specific team 

o You can “lock” this user or users by clicking on the Lock icon in the “Who?” section 
• Click the Green (+), Gray (●), or Red (-)  button to select the “Behavior” which you observed 

o If there are a large number of behaviors, you may scroll through the list of 
behaviors or select a filter to narrow down the list of behaviors 

• Add details where applicable (Section 2.2.2.3) 
o These features depend on configuration. 

• Click “Post” to save your observation. 

2.2.2.3. Observation Details 
Comments 

• Enter comments within the comment box 
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Apply custom timestamp 
•  On the right hand side of the screen, click the hyperlink titled “Set timestamp” → A prompt 

will appear → Click the text box next to “Timestamp” → A calendar pop up allows you to 
easily select a date → Drag the toggles next to “Hour,” “Minute,” and “Second” → Click 
“Done” → Click “Apply”. 

Apply a behavior tag 
• Click “Apply Tag” → Click the dropdown arrow next to “None Selected” to display a list of 

available tags configured to be used with this behavior in this event → Click “Apply.” 

Record an interaction 
• If an Observation event is configured for an interaction, an “Unlinked,” “Primary,” and 

“Secondary” tab will appear in the “Who?” section. Click on each tab and select which 
individuals you wish to make Primary, Secondary, etc. 

• Click “Post” to save your observation. 

2.2.3. Reviewing Completed Observations: 
• Review all observations made in an Instance by selecting “History” from the main 

Observation page. 
o You may search for observations you have made by using the “Search 

Observations” box. Type in this search box and click the icon to the right to 
complete your search. 

o Sort the list of observations in ascending or descending order by clicking the  
icon next to the column heading 

2.2.3.1. Review the details of an observation 
• Click the blue carrot next to the observation. The details and descriptives of this 

observation will appear.  

2.2.3.2. Edit an Observation 

• Click the  icon to change the people, behavior, comment, and timestamp. Make sure 
you hit SAVE when you make changes! 

2.2.3.3. Delete an observation 
• Click the  icon 
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2.3. Surveys 

2.3.1. Managing Surveys 
2.3.1.1. Turn Surveys On and Off 

You may find there are a lot of surveys to complete within an Instance. To reduce or restrict the 
number of surveys that a user can access at any one time, you can, “Activate,” or, “Deactivate,” 
surveys.  

• To make a survey “Active,” go to the Instance homepage and select the gear icon ( ) 
at the top RIGHT. 

o Select “Scheduler,” which will bring you to an interface that will allow you to do just 
that. You can add Start and End dates for Surveys, or simply make them Visible or 
Active on demand via this page.  

o You can also preview any survey in the list.  And remember to hit SAVE!     

2.3.2. Completing Surveys: 
All surveys must be taken within an Instance and, therefore, you must be signed into a specific 
Instance to utilize the Survey feature. As an Overseer, you typically complete a survey as yourself 
unless you are also assigned to an instance-level role. If you are not assigned a role that allows 
you to take a survey, you will be prompted to impersonate (i.e., shadow) another user. 

2.3.2.1. Shadow Users 

• Select Surveys ( ) at the top RIGHT 
• Click on the “Shadow someone else...” button. A dropdown menu will appear. 
• Select the person you wish to shadow. You will be presented with a list of surveys this 

person has access to. The survey will be recorded as the user you select. 

2.3.2.2. Complete a Survey on an Individual or Team 
• Once you have selected a survey, you will either be taken directly to the survey, or it will 

prompt you to pick a person if the survey has a target group.  
• Select the appropriate target, then click “Begin.” 
• Once you are in the selected survey, you can fill out the ratings and comments on the 

individual(s).  
• Click the  icon to add a comment. 
• Some ratings and comments may be required before you can move forward or submit the 

survey. These are indicated by a  * 
• If applicable, you may be able to view the descriptions for the scale items by hovering 

over the scale label. A popup dialogue box will appear with the anchor description.  
• There are navigation buttons at the bottom of the survey for you to use. 
• If the survey has multiple pages, you may select the “Back” button to return to previously 

completed pages.  
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• You may also select the “Cancel” button to either delete the survey or continue working 
on the survey at a later time.  

• At the end of the survey, click “Save” to save the updated survey.  

2.3.2.3. Complete a Hybrid Survey 
• Hybrid surveys enable you to view a report and complete a survey simultaneously. 
• Once you have selected a survey, you will either be taken directly to the survey and 

associated report, or it will prompt you to pick a person if the survey has a target group.  
• If the Hybrid Survey has multiple reports associated with it, click the  icon to navigate 

between the reports. 

2.3.3. Reviewing Completed Surveys: 
• Select “History” in the main Surveys tab → “Shadow someone else…” → Select the 

individual whose history you’d like to view 
o The history will show you the name of the survey, the target person of the survey, the 

timestamp when the survey was saved, and progress complete on that survey. 
o You may search for surveys by using the search box. Type in this search box and the 

survey list automatically filters to your search. 
o Sort the list of surveys in ascending or descending order by clicking the  icon next 

to the column heading. 

2.4. Data 

2.4.1. Spreadsheet Configuration 
2.4.1.1. Create a New Spreadsheet 

• Select the Data icon ( ) at the top RIGHT. Click “Spreadsheets” → “New Spreadsheet” 
• On this configuration page, you will be prompted to name your spreadsheet, record a brief 

description, identify who will be allowed to view the spreadsheet, whose data this 
spreadsheet will involve, whether to include members with inactive status, and if the 
spreadsheet may be imported, exported, and edited. 

• Make the appropriate selections, then click the “Create Spreadsheet” button. You will be 
prompted to identify the columns of data to be present in the spreadsheet. 

• Identifier will be a default column that will not be able to be edited 
• To add a new column, select from one of the available types of data on the left and drag 

that item to the right. Score is the most common type. Select the type of data that will be 
in this new column. 

• Indicate whether you wish to use an existing score or create a new score via the toggle 
buttons. 

• The “Column Label” name is what will appear in your spreadsheet as the column name.  
• Depending on your selection, additional details may appear that will need to be completed: 
• Score type is the format in which the data will be entered. 
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• The label is what will appear as the column name when the file is exported.  
• To arrange the order of the columns, click and drag the number icon next to the column 

name and move it to the desired location on screen. 
• When you have finished, click “Publish” to save the spreadsheet. 

2.4.1.2. Import an Existing Spreadsheet 
• To import an existing spreadsheet from another Instance (Measurement Period), click on 

the arrow on the “New Spreadsheet” button and specify the Module (Build), Instance 
(Measurement Period), and Spreadsheet you wish to import. 

2.4.1.3. Edit Spreadsheet Configuration 
• To edit the properties of an existing spreadsheet, click on the blue carrot next to the name 

of the Spreadsheet and click “Edit.” 

2.4.2. Utilizing Spreadsheets 
2.4.2.1. View/Edit the Content of a Spreadsheet  

• Click on the name of the spreadsheet or click on the blue carrot then select “Open.”  
• This opens a spreadsheet view of the variables. You can edit any or all fields in this view 

with the exception of the first column(s) - the Identifiers. These columns will be greyed 
out. 

• Click on a “cell” in a column to edit that particular data field or variable. When you finish 
with that cell, hit <ENTER> or <TAB> on your keyboard or select a new cell with your mouse. 
This will lock in the value for that cell.  

• When you are finished editing, be sure to click the “Save” button at the bottom of the page 
to lock in all values on that page.  

• Sort the column of data in ascending or descending order by clicking the column heading. 

2.4.3. Importing/Exporting Spreadsheets 
2.4.3.1. Export a Spreadsheet to a .csv File  

• Click on the blue carrot icon next to the name of the Spreadsheet and click “Export.” The 
file will download automatically. This exported file will contain the proper format and 
column headers that you’ve configured.  

2.4.3.2. Import a File into an Existing Spreadsheet  
• Click on the blue carrot icon next to the name of the Spreadsheet and click “Import.”  
• You will be prompted to browse for the file to be imported. If the import does not go in 

successfully due to a mismatch of names or data types, be sure to check your 
spreadsheet to ensure that the data in it matches the data type it is looking for. 

o Excel files that contain formulas cannot be imported, they must be “values only” 
• Click “Import File” to upload the file. A pop-up window will appear indicating you have 

successfully uploaded the spreadsheet.  
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2.4.4. Data Design 
2.4.4.1. View Score Variables 

• Click the Data icon ( ) at the top RIGHT → “Variable Manager” 
• You may filter for scores by using the dropdown box, or you may search for scores by 

using the search box. Type in this search box and the list automatically filters to your 
search. 

• Sort the scores by columns in ascending or descending order by clicking the  icon next 
to the column heading. 

• Click the variable name of the variable to view more information about the scores 
o From this page, you can click the “Data” tab to see all of the values for this score 
o For calculations, click the “Options” tab to see how this score is calculated 
o For transformations, click the “Options” tab to see the evaluation this score is 

based off 

2.4.4.2. Score Mappings 

Score mappings allow you to link instance-level scores across instances and modules. 
Essentially, this feature creates a group of similar scores to facilitate higher-level analysis at the 
organizational level. While Overseers do not have access to the organizational level, they can 
still add scores to a mapping at the Module level. To do this: 

• From the Module homepage, click the Data icon ( ) at the top RIGHT → “Tools” → 
“Mappings” → “New Score Mapping.” 

• Enter the name of the group of scores (ex. Run Times) → “Save.” 
• Click the blue carrot next to the name → “Add Mapped Score” → Specify the build, 

measurement period, and variable name → “Add.” 
• After adding all of the variables to map, you can view all of the values by clicking the name 

of the score mapping. 
o Click the drop down menu under “Operation” to change the type of values you are 

viewing 

2.4.4.3. Autotags 

Autotags automatically add a label to surveys, observations, or other input depending on a 
specified date range. This feature is useful for courses that are broken down into multiple 
phases. To enable autotags: 

• From the Instance homepage, click the Data icon ( ) at the top RIGHT → “Manage” → 
“Autotags” → “New Tag.” 

• Enter the date range for which you want the tag to apply and the name of the tag (ex. 
Phase 1) 
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2.4.5. Data Management 
2.4.5.1. Data Points 

This tool lets you quickly edit, export, or delete multiple people's data. 

• From the Instance homepage, click the Data icon ( ) at the top RIGHT → “Data Points” 
• You can filter this page with the following drop down menus: 
• Scores, Evaluations, Descriptives, Ranks 
• Subjects (Targets) 
• Assessors 
• Date Range 
• You may search by using the search box.  
• Sort the list of data in ascending or descending order by clicking the  icon next to the 

column heading 
• Edit scores from this page by clicking the name of the score 
• Delete scores by checking the box next to the row of data → Click “Remove Selected” 
• Export scores by checking the box next to the row of data → Click “Export to CSV” 
• You can also set baseline and exclude scores from this page (see Section 2.1.2.8) 

2.4.5.2. Data Export 

This tool lets you select and export data into a .CSV format if you want to analyze data using 
your favorite statistical analysis tool. This is especially helpful when you are exporting scores 
that were entered in a time format. 

• From the Instance homepage, click the Data icon ( ) at the top RIGHT → “Tools” → “Data 
Export.” 

• Click on the type of data you want to export and a prompt will appear: 
• Check the box next to the variables you want to export and click “Add Selected” 
• If the scores are entered in times and you want to keep this format, click the checkbox 

“Format as Time.” Otherwise, these times will be formatted as seconds. 
• Click “OK.” 
• Use the role filter to specify the role of individuals you want the data exported for. 
• Click “Export.” 

2.4.5.3. Data Transport/ 3rd Party Import 

These features are most often used for standalone environments. Data Transport allows you to 
export and import all of the data and configurations within GideonSoft from one computer to 
another computer. For this to work, both computers must have GideonSoft installed on them. 3rd 
party import enables you to import any data collected through other sources. To import data 
from other sources, GideonSoft must be configured to accept this type of data. For the 
purposes of this document, instructions will be directed towards the former use – transporting 
data for standalone environments. 
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• To export the data, from the Instance homepage, click the Data icon ( ) at the top RIGHT 
→ “Tools” → “Data Transport” → “All data” → “Export” 

• Save the file on a portable device 

• To import the data onto a new computer, click the Data icon ( ) at the top RIGHT → 
“Tools” → “Data Transport” → “Import” 

2.4.5.4. Roster Transport 

The Roster Transport tool is used in standalone environments ONLY. If you simply want to import 
people from another Instance, you would use the Create and Add Multiple People at Once feature. 
Instead, if you want to take the same people within an Instance, the Roster Transport tool is a 
means of copying people exactly as they are from one computer to another. Within an Instance, 
it lets you export their roles, groups, and statuses so you don’t have to input all of this information 
in on each computer. It is not meant for using across instances or versions of the software. 

• From the Instance homepage, select the People icon ( ) at the top RIGHT, then “Manage,” 
then “Roster Transport.” 

• To import roster, click “Import Roster” 
• To export roster, click “Export roster” 
• The roster will export to a .gd file for your continued use 

2.5. Reports 

2.5.1. Report Assignments 
Overseers must assign Basic Users and Power Users to specific reports in order for them to be 
allowed access to view them. You can also exclude certain users from viewing a report. 

2.5.1.1. Assigning Reports 
• Select Reports ( ) at the top RIGHT → “Design” → Click the blue carrot next to the name 

of the report → “Assignments” 
• Click “Add New Assignment” and select one of the following options: 
• User: Assign a report to a specific user 
• Permission Set: Assign a report to all users with a specific permission set (ex. Power User) 
• Role: Assign a report to all users with a specific role (ex. Student) 
• Select the user/permission set/role 
• Click “Allow Selected” to grant access or “Exclude selected” to deny access 

2.5.2. Viewing Reports 
2.5.2.1. From Reports Homepage  

• Select Reports ( ) at the top RIGHT. 
• You will be presented with a list of reports that you have permission to view. 
• There are two ways to access the Reports: 



27 
 

• Click on the survey name directly. 
• OR click the blue carrot and select “View Report.” 
• If you are prompted to select an individual or team before continuing, make the 

appropriate selection and click “View Report.” 
• If there are multiple reports or multiple individuals, use the left and right arrow buttons to 

maneuver through the reports or use the Document Map on the left and select the 
appropriate report. 

2.5.2.2. From Individual Instance Profile Page  

When there are a large number of individuals in an Instance, individual reports will load 
faster when they are run from the individual’s profile page. To run reports from a profile 
homepage: 

• From the People tab, select the individual to run the report on. 
• Click at the top RIGHT live tile, “Reports” → Select a Report and a new window will open. 

2.5.3. Exporting Reports 
2.5.3.1. Export a Report  

 From the Reports homepage page, click the blue carrot next to the name of the report. If 
applicable, the options to export to an Excel file or PDF will appear.  

 OR after running the report, click on the disk icon → make your selection on the type of 
file (PDF or Excel). 

 After exporting a report, you can print the downloaded file. 

2.6. Feedback Tool 
The feedback tool allows instructors to utilize pre-selected pieces of information that feed 
reports. For example, an instructor is completing a counseling statement and there are certain 
statements instructors typically provide. This feature can incorporate those pieces of 
information so that instructors can select them and modify, rather than typing them from 
scratch.  

2.6.1. Content Categories 
Since the purpose of the Content Library is to provide common feedback for evaluators, try to 
organize the category types in a broad manner then get more specific. Compare the 
functionality to the iTunes library. Category A is the broadest category (e.g., Genre), Category B 
will be a little more specific (e.g., Artist), and Category C (e.g., song) will be the most specific of 
the categories. The content items themselves is where you can get more precise and give the 
specific feedback. 

To begin creating the content categories: 
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• From the Module homepage, click the gear icon ( ) at the top RIGHT → under the section 
“Feedback Tool,” click “Content Categories” 

o There will be three category types displayed. Unless they've been renamed, the 
default names are "Category A", "Category B" and "Category C". If any categories 
have been created, they will be displayed as well. 

o These will be the only three categories to configure. 
• To rename a category type, click on the name (it should be a blue link).  

o A dialog box will prompt you "Enter a name for this category type".  
o Type in a name and press "OK". 

• To rename a category, click the  icon next to the category name. 

• To delete a category, click the  icon next to the category name. 
• To add a category, select "Add new category" at the bottom.  

o You will then be prompted to select a category type from the drop down, and 
provide a category name.  
 This new subcategory will be contained under the broader category. 

o Select "OK". 

2.6.2. Content Library 
Once category types and (sub)categories have been set, now it's time to begin creating some 
actual feedback comments. 

• Under the section “Feedback Tool,” click “Content Library” 
o On the Manage content page, you should see the three category types and all the 

categories already configured. If any feedback items have been created, they will 
also be displayed. There is a legend that helps more easily identify which category 
types each feedback item belongs to. 

• To add a new item, click "Add new feedback" at the bottom of the page.  
o This will open a dialog box where you can provide the text of the feedback and 

select the categories to which the feedback item will belong.  
o Select "OK". 

• To edit an existing item, click on the  icon next to the item text.  
o This will open the same dialog box where you can change the text of the feedback 

and the categories.  
o Select "OK" when done. 

• To delete an item, click the  icon next to the item text. 

• To duplicate an item, click the  icon next to the item text. This is handy to easily create 
similar types of feedback that require slight but important differences. 
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2.6.3. Content Rules 
Once the Content Library has been populated, Content Rules allows you to integrate this 
feedback into other areas of GideonSoft, and automate the process of getting it into the hands 
of the individual(s) being evaluated. You can create a set of rules that define what group to 
focus on, what scores to watch, and then link to the appropriate items in the Content Library; 
thus creating a kind of flagging system. 

• Under the section “Feedback Tool,” click “Content Rules” 
• Click “New Ruleset” to create a rule. 

o You will be prompted to provide a Name, select a Role, define a Weight and select 
the Type of ruleset (all parameters are required). 
 Name should be indicative of the ruleset's purpose. 
 Role identifies who this ruleset will apply to. 
 Weight is the weight applied to any evaluations created by this ruleset. 

• A weight may be used to rank order rulesets. 
 Report type determines that the ruleset will be applied during the report 

process. 
• Select either Monitor or Off as the Type.  

o Monitor determines that the ruleset will be applied when 
clicking Process Rules (or performing a Hierarchy update 
elsewhere in the GideonSoft system) and will create an 
evaluation with that feedback text. 

o Off turns off or deactivates the ruleset. 
• Click “Save” once complete. 

Once that information has been entered, an “Add New Rule” button will generate under those 
parameters. BEFORE YOU CAN BEGIN ADDING RULES, SCORES MUST FIRST BE CONFIGURED. 

• To add a new rule, click “Add New Rule” 
o You will be prompted to define the following parameters when adding a new rule. 

 Transition - if this is the first rule in the set, only one option will be displayed 
("IF"); from the 2nd rule on, you can select "AND", "OR" or "ELSE." Depending 
on your selection, the options below will change. 

 Score - you must select a score to be monitored from the drop down. 
 Rule - select a logical operator: greater than (>), less than (<), equal to (=), 

not equal to (<>), greater than or equal to (>=) or less than or equal to (<=). 
 Value - this sets a threshold for the score to completely define the scenario 

you're targeting 
 Category A, Category B, Category C - You will select your categories from 

Category A, Category B, and Category C to find your feedback item to which 
your rule will apply.  

 Feedback to be added if this value evaluates to TRUE: This field displays 
what feedback will be recorded. 
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• You may choose to edit the feedback that has been configured for 
this rule by checking the box next to “Override Feedback Text.” 

• If you make any changes to the feedback text and wish to revert 
back to the original text, deselect the check box next to “Override 
Feedback Text.”  You will be asked to confirm your selection by 
clicking “Proceed.” 

o Click “Save” to save your work.  

• To edit an existing rule, click the  icon next to that rule. 

• To set up notifications on an existing rule, click the  icon next to that rule. 
o You will be prompted to select the role(s) or individuals who should receive a 

notification when the rules evaluate to TRUE. 
o Note: Only individuals who subscribe to feedback notification alerts with valid 

email address will receive email. 
o To send a notification to the person being evaluated by the rule, “Send a 

notification to the person being evaluated by the rule.” 

• To delete an existing rule, click the  icon by that rule. 

The rulesets that have been created will populate on the “Content Rules” page.  

o To edit an existing ruleset, click the dropdown arrow, click “Edit.” 
 Or, click directly on the name of the ruleset 

o To remove an existing ruleset, click the dropdown arrow, click “Remove.” 
o To filter rulesets, type the name of the ruleset you are looking for in “Filter 

rulesets…” 
o You may also sort the rulesets by clicking “Sort by…”  

 

3. Mobile Application 
The mobile app is designed for on-the-go data collection. The web version is geared towards 
managing and inputting large amounts of information at once. While it is expected that most of 
your time will be spent on the web-version, you may need to be familiar with the mobile app, as 
well. 

3.1. People 

3.1.1. Viewing People 
• Tap the   icon. 
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• You may search for observations you have made by tapping the “Search” bar →Type in 

this search box → Tap the  icon to the right to complete your search. 
• Slide your finger up to reveal more people.  
• To view a person in more detail, tap their name from list format. You will be taken to this 

person’s Instance profile. From this page you can: 
• Select an individual for Observations 

• Tap the  icon located under the person’s profile picture. 
• This will take you to the Observation homepage and the individual will already be selected 

under “Who?” 
• Select an individual for Surveys 

• Tap the  icon located under the person’s profile picture. 
• This will take you to the list of surveys targeted at the individual. 
• To deselect the individual’s filter, tap the  icon at the top right of the screen. 

3.1.2. Lineups 
“Lineups” are dynamic teams that give the user the ability to create a temporary team of people 
that is only visible to that user. It is essentially a person filter that can be used to filter down the 
list of people in an Instance. 

3.1.2.1. Create a new Lineup 
• Tap the   icon. 
• Tap the Lineups box at the top right of the screen. 
• Tap two or more people to highlight their names. 
• You can slide your finger up to reveal more options. 
• Tap the “Name your lineup” text bar → Type in the lineup name → Tap “Create” to the right 

to create your lineup. 
• The  icon indicates the Lineup is selected. By default, the lineup you created is 

"selected" so when you go in to make observations or take a survey, that lineup is selected 
as a filter for you. However, you can deselect this lineup to go back to your original full list 
of people. 

3.1.2.2. Deselect a Lineup 
• Tap Deselect at the top left of the screen. 
• From here you can create additional Lineups. 

3.1.2.3. Edit an existing Lineup 
• Select the Lineup by tapping the name → tap Edit at the right left of the screen. 
• Add or remove people from by tapping their names.  
• Names that are highlighted will become a part of the Lineup. 
• Tap “Create” to save your edited Lineup. 
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3.2. Observations 

3.2.1. Recording Observations 
• Tap the  icon. 
• Tap “Where?” to select the “Event” in which you observed the behavior. 
• Slide your finger up to reveal more options.  
• Tap “Who?” to select the individual(s) on which you will make the observation. 
• Select individuals by highlighting their name, deselect by tapping the name again. 
• You may select more than one person at a time to record the same behavior. 

• For team events, you can filter this list by tapping the  icon, and selecting a team from 
the list. 

• Tap “Continue.” 
• Select the “Behavior” which you observed: 
• Negative behavior: Tap the red button. 
• Neutral behavior: Tap the gray button. 
• Positive behavior: Tap the green button. 
• Highlight the behavior and add details where applicable 
• Some of these features may or may not be utilized in a given event. 
• Click Continue. 
• Click the  icon next to “Where?” to make another observation on the same event or click 

the  icon next to “Who?” to make another observation on the same person/people 
selected. 

• You may also tap the  icon at the top left corner of the screen to cancel the observation. 
• Click “Post” to complete the observation. 

3.2.1.1. Observation Details 
Comments 

• Enter comments within the comment box by tapping on the “Comments” box above the 
“Continue” button. 

• When connected to WiFi, utilize voice-to-text by tapping the  icon on your keyboard. 
• Tap “Done” to save your comment. 

Apply a behavior tag 

• Tap the  icon to reveal a list of behavior tags. 

Record an interaction 
• Tap “Who?” → “Primary” (purple tab at the top of the screen) → Highlight the individuals 

involved in the primary interaction. 
• If any individual(s) were played a secondary role in the interaction, select “Secondary” → 

Highlight the individuals involved in the secondary interaction → Continue. 
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Attach a photo 
• Tap the  icon in the top right corner of the “Where?” and “Who” screen. 
• You can use take a picture using the front or rear camera, or attach a photo from the 

device’s library. 

3.2.2. Reviewing Observations 
• Review your observations by tapping the  icon from the “Where?” and “Who” screen. 
• You may search for observations you have made by tapping the “Search” bar →Type in 

this search box → Tap the  icon to the right to complete your search. 
• Refresh the list of observations by swiping down on this screen. 

3.2.2.1. Delete an observation 

• Swipe left on the observation to reveal the  icon → Tap the  icon. 

3.3. Surveys 

3.3.1. Recording Surveys 
• Tap the  icon. 
• You will be presented with a list of surveys that you have permission to complete. 
• Slide your finger up to reveal more options.  
• Simply tap on the survey name to begin completing it.  

3.3.1.1. Complete a survey on an individual or team 
• Once you have selected a survey, you will either be taken directly to the survey, or it will 

prompt you to pick a person if the survey has a target group.  
• Tap the appropriate target. 
• Once you are in the selected survey, you can fill out the ratings and comments on the 

individual(s).  
• Click the “Comments…” text box to add a comment. 
• Some ratings and comments may be required before you can move forward or submit the 

survey. These items are indicated by a red line. 
• If applicable, you may be able to view the descriptions for the scale items by tapping the 

scale label at the top of the screen. A popup dialogue box will appear with the anchor 
description. Slide your finger up to reveal all of the descriptions. 

• There are navigation arrows at the bottom of the survey for you to use. 
• If the survey has multiple pages, you may view the Table of Contents by tapping the page 

numbers (ex. 1 of 10) at the bottom-middle of the screen. 
• Scroll to the bottom of this page to reveal a “Submit Survey” button. 
• You may also tap the  icon at the top left corner of the screen to cancel the survey. 
• At the end of the survey, click “Submit” to save the completed survey.  
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3.3.2. Reviewing Surveys 
• From the screen with the list of Surveys, slide your finger from left to right over the name 

of the Survey you wish to view the history of to reveal the  icon. Tap the  icon to view 
the Survey history. 

3.3.2.1. Edit a survey 
• From the Survey history screen, tap the survey session to go back into the survey to review, 

revise, or finish your survey. Make sure you hit “Submit” if you make changes! 

3.3.2.2. Delete a survey 

• From the Survey history screen, slide your finger from right to left to reveal the  icon. 

Tap the  icon to delete the survey session. 
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